Chapter

Dimensioning the
Rectangular Problem

In this chapter, you will cover the following to World Class standards:

Creating new layers in an AutoCAD drawing

Changing entities from one layer to another

Placing center marks on the drawing

Using the Dimensioning Panel

Using the Linear Dimension command to dimension a part
Setting system variables using the Dimension Style Manager
Using the Aligned Dimension command to dimension a part
Using the Radius Dimension command to dimension a part
Using the Diameter Dimension command to dimension a part
Using the Break Command to shorten a line

Using the Angular Dimension command to dimension a part
Using the Properties Tool to Modify a Dimension Variable
Using the Edit Text Tool
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Creating New Layers in an AutoCAD Drawing

If you have used any graphical software in your career, you will already be familiar £Z
with the concepts of layers. If you are not, think of layers as you would a sandwich:
each different item has its own flavor and color, but when you stack them all together

you have a complete, delicious meal. The layer system in a CAD program allows you

to view, revise, or control information on one layer without disturbing objects on other
layers... like taking the mustard off of a sandwich without removing the bread. In
chapter 2, The Rectangular Problem was drawn on layer 0, the AutoCAD default layer.

You can see the current layer listed in the Layer Control list box in the Layers panel

under the Home tab. (Figure 3.1). To create new layers using the Layers Properties
Manager, select the Layer Properties button from the Layers panel.
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Figure 3.2 — The Layer Properties Manager window

To dimension your part, you need make three new layers: the Dimension layer for dimensions,
the Center layer for centerlines, and the Text layer for text and notes. Select the New button to
add a new layer under the 0 layer. Immediately, the layer name is ready for editing, so type
“Dimension” and hit ENTER twice to add another new layer. Type “Center” and hit ENTER
twice to add another one more new layer. Type “Text” and ENTER once to finish adding new
layers. Next, you need to assign the layers different colors to help distinguish between them. To
change the Dimension layer color, place your cursor over the color box in the Dimension layer
row and single left click with your mouse. The Select Color window will appear in front of the



Layers Properties Manager (Figure 3.3). Select red from the Standard Colors row and select the
OK button. You will now see that Dimension layer is red. Repeat the process to make the
Center layer green and the Text layer blue.
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Figure 3.3 — The Select Color window

To finish creating and modifying layers, you need to change the Continuous linetype to a Center
linetype for the Center layer. Place your mouse arrow over the text that reads “Continuous” in
the Center layer row and single left click with your mouse. The Select Linetype window will
appear in front of the Layers Properties Manager (Figure 3.4). Note that only the Continuous
Linetype is loaded, so select the Load button and the Load or Reload Linetypes window will
appear. Scroll down, highlight the CENTER linetype as shown in Figure 3.5, and select the OK
button. Highlight the CENTER linetype in the Select Linetype window and select OK. You
will now see that the Center layer has a CENTER linetype. Exit the Layer Properties Manager
to continue.
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Figure 3.4 — The Select Linetype window Figure 3.5 — Load or Reload Linetypes
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Figure 3.6 — Four completed layers

Placing Centerlines on the Drawing

Now you can set up your centerlines. You placed the centerlines on the drawing right after
drawing the 6 by 4 perimeter, so you only need to change layers for both of these lines. Select

the vertical and horizontal centerline, noticing that they have become dotted.

Select the

dropdown arrow to the right of the Layers Control list box to open the list. Highlight the Center

Layer.
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Figure 3.7 — Selecting the Center layer in the Layer Control list box
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The Center layer now replaces the 0 layer in the
Layer list box to show that these two lines now

Q O reside on the Center layer. Press the ESC key
on your keyboard and the lines are no longer
dotted and are removed from the selection set.
Centerlines are critical in the dimensioning

process since they show symmetry in a part and
reduce the amount of dimensions on the
drawing.

Figure 3.8 — The two centerlines

Placing Center Marks on the Drawing

Dimensioning is one of the easiest tasks to do in AutoCAD. In the last chapter you
specified all of the measurements and values of the part, so now you only have to @
reference the Osnap points and layout the dimensions around the drawing.
Technicians with artistic talent will enjoy the freedom to create a visually appealing
dimension layout.

In the Layer Control list box, select the Center Layer. Next, you need to place center marks
inside the four 0.5 circles and inside the 0.75 arcs of the rectangle. Select the Center Mark tool
on the Dimensions panel under the Annotate tab (you may have to expand the Dimensions panel
by clicking the small black triangle next to the Dimensions panel label to find the Center Mark
tool). The mouse arrow will turn into a pick box. Select the 0.5 circle in the lower left corner of
the part (Figure 3.10). A green center mark will appear inside the circle. Hit ENTER to repeat
the command. Follow a clockwise or counterclockwise pattern so you to place a mark on every
circle on your drawing and improve your drawing efficiency. Lastly, select the two 0.75 arcs on
the inner detail. You will have six center marks on the drawing when finished (Figure 3.11).
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Figure 3.9 — The Dimension panel expanded
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Figure 3.10 — Placing center marks Figure 3.11 — All 6 center marks placed

Did you notice how easy the dimensioning tools work? As long as you draw your part
accurately, the associated dimensions in the CAD software will do the rest of the work.

Compare your own dimensions with the reported dimensions to check your work.

The Linear Dimension Command

The first dimension you will place is 1.5000 from the left corner of the top indent
to the centerline. Before placing any dimensions, make sure to select the
Dimension layer from the Layer Control list box. Next, select the Linear
Dimension tool on the Dimension panel under the Annotate tab. The command
line will ask you to “Specify first extension line origin or <select object>", so
select the endpoint Osnap at the top of the left side of the top indent. The
command line will immediately prompt you to “Specify second extension line
origin”, so select the endpoint Osnap at the top of the vertical centerline. The next
prompt on the command line will be to “Specify Dimension line location or
[Mtext/Text/Angle/Horizontal/Vertical/Rotated]”, so abstractly select a point
above the part so the dimension is neatly placed close to the part but so none of the
dimension, dimension lines, and dimension extension lines are on the object lines
of the part (Figure 3.12).
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Figure 3.12 — Your first dimension
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Figure 3.13 — The Dimension Style
Manager window

The 1.5000 dimension shows four decimal
places. On a sheet metal part that is going to be
held to a 0.010-inch tolerance (plus or minus), a
four-place decimal is unnecessarily accurate
and may cause confusion as some companies
use decimal places to convey tight tolerances.
You need to change the dimension to show only
two decimal places. Also, the dimension text is
0.18” high. Your drawing only needs
dimension text that is 0.125” high.

To change the system variables controlling
dimensions, select the small arrow in the
bottom left-hand corner of the Dimensions
panel to open the Dimension Style Manager
window. Select the Modify button to access the
Standard dimension variables (Figure 3.13).



A Modify Dimension Style: Standard

S5

| Lines | Symbals and ﬁm::w5| Text |Frt

I Primary Units INtemate Lnits | Tolemncesl

Text appearance

Text style: [Standad ][] a‘ 1.015¢ ’~

Text color; [. ByBlock V] _-T_ /\

Fill color: [D Mone v] 1'1_fi X
‘ Text height: = 80° >/

Fraction height scale: 0000 RO.2045
i [ Draw frame around text

Tend placement Text alignment

Vertical: [Centered "] @ Horizontal

Horizortal: [Centered .] - o o

() Migned with dimension line

l View Direction: [Leﬂ-to—ﬂjght -]

Cffset from dim line: 00500 = (2150 standard
|

0K | | Cancel | | Heb

]

h

‘ Modify Dimension Style: Standard

Figure 3.14 — The Dimension Style Manager window, Text tab
S |

| Lines IS)'mbols and Amows | Text | Fit

| Primary Units |Ntemate Units IToIemnces|

Linear dimensions
Unit format: [ Decimal - ]
Precision [D.[N] - ]
0
Fraction format: 0.0
o0 |
Decimal separstor: 0.000
0.0000
Round off: 0.00000
0.000000
Prefic 0.0000000
X 0.00000000
Suffic:
Measurement scale
Scale factor: 1.0000 S
[T] Apply to layout dimensions only Anguiar dimensions
Zero suppression Urits format: [Decimal Degrees v]
[[] Leading [ Trailing
.‘31|.l|-t_1-1.1nﬂ'rtﬂ5jact0|:: Dfect Precision: [ﬂ 7]
el - Dinch Zern suppression
Sub-unit suffix: Hnenes [ Leading
[C] Trailing
[ ok | [ camcsl | [ e

There are 7 tabs in the
Modify Dimension Style
window: Lines, Symbols
and Arrows, Text, Fit,
Primary Units, Alternate
Units, and Tolerances. Go
to the Text tab and change
the text size to 0.125
(Figure 3.14).

Select the Primary Units
tab to change decimal
places. You can change
the settings for both Linear
Dimensions and Angular
Dimensions. In the
Precision list box in the
Linear Dimensions section,
select the dropdown menu
to open the list and
highlight  <0.00”. In
addition, you can change
the Precision in the
Angular Dimensions list
box to 0.0 (Figure 3.15).

Figure 3.15 — The Dimension Style Manager window, Primary Units tab
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More Linear Dimensions

You can see that the 1.50 dimension now has the settings you specified for the r_.‘
Standard dimension style (Figure 3.16), so now you can place additional
dimensions on the part. Do not want to haphazardly add dimensions; rather, follow  Dimension
a pattern to improve efficiency and avoid errors, like forgetting a dimension.
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When placing new dimensions on a drawing,
continue to specify extension line locations
using Osnap points on the part (black line) and
not off any existing dimension extension lines
(red lines). The problem with dimensioning off
dimension extension lines is that they do not
always reference exact points of the part. All
dimension extension lines must reference the
original part or centerlines.

Figure 3.16 — The reformatted dimension
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Figure 3.17 — 3 linear dimensions

Finish dimensioning the top of the part, placing
3.00 and 0.25 dimensions as shown in Figure
3.17. The Linear Dimension tool allows you to
place horizontal or vertical dimensions by
pulling the dimension in the third step towards
direction of placement. Do not worry that the
lower dimension extension line of the 0.25
dimension is overlaps the part. You will
remove that dimension extension line later
using the Properties tool on the Standard
toolbar. You can move the “0.25” text inside of
the dimension extension lines by first placing
the dimension and then selecting it and using
the handles to move the label in between the
extension lines. It may take some practice to
learn to modify dimensions with the handles.
Be mindful of the Osnap points you may be
referencing.
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Figure 3.18 — Dimensioning the right side

Following a clockwise pattern, now place
dimensions on the bottom of the drawing.
Dimension extension lines may cross each
other, but according to ANSI and 1SO
worldwide drafting standards, dimension lines
(red lines with arrows) may never cross each

other.  Place the 2.50, 5.00 and 6.00
dimensions in order. Lastly, place the 0.50
dimension, reinforcing the  alignment

technique you used previously. Make the
third selection when placing the 0.50
dimension on the 5.00 dimension line.

Continue to use the Linear Dimension
command by hitting ENTER each time to
repeat the command. Always dimension from
the inside to the outside of the part so you
always have room for more dimensions. Place
the 1.50, the 3.00 and 4.00 dimensions, trying
to space them evenly (Figure 3.18). To place
the 0.50 dimension, start by selecting the right
endpoint of the 0.50 centerline. For the third
selection to show position, select the 1.50
dimension line. The dimension lines will align.
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Figure 3.20 — Dimensioning the left side

Figure 3.19 — Dimensioning the bottom side

Place the last two dimensions on the left side of
the drawing, starting with the 0.80 dimension
and then placing the 1.60 dimension. There are
13 linear dimensions on this part.

3-10




The Aligned Dimension Command

Now you are ready to place the two Aligned Dimensions. The Aligned Dimension i ==
tool is used to easily place a dimension in alignment with two selected reference - ™= )
points. You are going to use the Aligned Dimension command to place two
dimensions on the drawing: to define the distance from the center of the part to the
center of the 0.75 radius, and then the distance between the centers of both 0.75 radii.
In order to easily select the intersecting point of the centerlines, you need to change
your Osnap settings.

|| Linear =

Right click the Object Snaps tool on the bottom of the screen and select Settings from |=
the menu to bring up the Object Snaps tab in the Draft Settings window Select the |:|
Clear All button to clear all previous Osnap settings. Check the Intersection checkbox

and press OK to close the window. Now the other Osnaps will not interfere with your

ability to select a reference point. Feel free to change Osnap settings at key times in

the drawing process, such as between major command functions like drawing lines and

circles or when moving from drawing to dimensioning.

Select the Aligned Dimension tool by clicking the word Linear on the Dimension panel to open
a drop-down menu. You can then select the Aligned Dimension tool. Place the 1.50 aligned-
dimension on the drawing by selecting the intersection of two centerlines and positioning the
dimension as shown in Figure 3.21. Next, place the 3.00 aligned-dimension on both 0.75 radius
centerlines and position the 3.00 dimension text as shown in Figure 3.22.

) T T ] T
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) — N
Figure 3.21 — 1* aligned dimension Figure 3.22 — 2" aligned dimension

Using the Radius Dimension Tool

The Radius Dimension tool is as easy to use as the Center Mark tool. Select the & ™,
Radius Dimension tool in the same way you selected the Aligned Dimension tool. '\
The mouse pointer will change from an arrow to a pick box to allow you to
choose an arc or circle in which to place a radius.
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To place a 0.50 radius on the lower left corner
of the part, select the Radius Dimension tool on
the Dimension toolbar. Place the pick box on
the 0.50 radius arc (black arc). A second pick
of the mouse will place the R0.50 dimension
text on the drawing. Notice that moving your
mouse around the circumference of the center
point will change the location of where the
pointing arrow intersects with the arc. A red
center mark is placed on the drawing with the
radius dimension (Figure 3.23).

Figure 3.23 — First radius dimension
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The second radius reinforces the lessons of
placing the first radius dimension on the
drawing. Again, place the pick box on the 0.40
radius arc (black arc). A second pick of the
mouse will place the R0.40 dimension text on
the drawing (Figure 3.24).

The third and last radius dimension on this
drawing is the smallest arc and can be very hard
to select. Use the corner of the pick box to grab
the 0.06 radius arc (Figure 3.25) and place the
R0.06 dimension text as shown in Figure 3.26.

Figure 3.24 — Second radius dimension
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Figure 3.25 — Selecting the last radius

Figure 3.26 — The 0.06 radius
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Using the Diameter Dimension Tool

You need to place two dimensions showing diameters on the drawing. Select the Diameter
Diameter Dimension tool in the same manner that you selected the Radius and
Aligned Dimension tools.

. .00- | Once again, the aperture cursor will change to a
pick box. Select the 0.50 circle located on the
upper right hand corner of the part. Similarly to
2050 [~ 1.%0 4‘ the Radius Dimension command, a second

selection will place the diameter text on the
drawing (Figure 3.27).

‘ 1.50
160 \<//

Figure 3.27 — The 0.50 diameter

The second diameter you will place on the
9050 1% \ | drawing is on the 2.00 diameter hole in the
025 center of the part. Select the Diameter

Dimension tool on the Dimension toolbar and

22 00 the aperture cursor will change to a pick box.
Select the 2.00 circle. Make your second
selection to place the dimension text on the

1 50 drawing (Figure 3.28).

Figure 3.28 — The 2.00 diameter

Using the Break Command

The Break command is a rarely used because the Trim command, added later to the list
of functions in AutoCAD, performs its function much more effectively in many cases. [:l
It is designed to abstractly remove portion of a line segment. Therefore, the Break
command is perfect for your use when dimensioning a drawing. You are going to

place your own dimension extension line in the drawing. Per ANSI or ISO standards,

a dimension extension line cannot touch an object or centerline, so you will use the

Break command to shorten the line segment and create a small gap between the line

you added and the centerlines.
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First you need to draw a line from the intersection of the major centerline to the centerline of the
upper right 0.40-radius arc. The Intersection Osnap is still on, so select the Line command on
the Draw panel under the Home tab. Select the first intersection as the first point of the line
segment. Select the second intersection to create the line segment. Press ENTER to end the
Line command. You have drawn your first dimension extension line without the Dimension
tools (Figure 3.29).

Figure 3.29 — Adding a line segment Figure 3.30 — The broken line segment

Select the Break command on the Modify panel; you may have to expand it. The command line
will prompt you to “select object”, but this selection is more complicated than just picking the
line. The point on the line that you use to select it will be the first cutting point in the break
sequence. Pick close to the bottom endpoint of the line segment. Next the command line will
prompt you to “specify second break point or [First point]”. You need to pick below and to the
left of the line. If you do not pick clearly below and to the left of the first selection point, you
may end up with a small line segment. Remember, if you ever make a mistake, you can Undo it
by hitting CTRL+Z or using the Undo arrow at the top left of the screen. Repeat the Break
command by pressing ENTER and remove the top part of the line segment so that you end up
with a shortened line as shown in Figure 3.30.

Using the Angular Dimension Tool

Another easy command to use happens to be the last dimension tool in this problem: A anguer
the Angular Dimension tool. It is located on the Dimension panel in the same drop-

down menu as the Radius, Diameter, and Aligned Dimension tools. Select the Angular
Dimension tool and select two converging lines (non-parallel) to place the degree
measurement on the drawing. For the first dimension, select the red dimension
extension line you just drew. Then, select the horizontal centerline directly below the
dimension extension line. You will need to make a third selection to place the 45.0-

degree dimension text on the drawing (Figure 3.31). You may find it easier to place

the dimension without interfering with any other entities if you turn the Ortho mode off

(F8).
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There are a few changes you need to make to
finish the dimensioning of the part that will add
to the clarity of the information.

Three red centerlines need to be removed from
the drawing. Also, a red dimension extension
line needs to be removed from covering the
object line on the 0.25 dimension. Finally, you
need to add a note that reads “4 holes” under
the 0.50 diameter dimension text.

Figure 3.31 — An angular dimension

Using the Properties Tool to Modify a Dimension Variable

becomes highlighted With the 0.25 dimension highlighted, click on the Properties icon
and the Properties window will appear. The variables that represent the 0.25 dimension
are listed in the General, Misc, Lines and Arrows, Text, Fit, Primary Units, Alternate
Units and Tolerances categories.
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Change to the View tab on the ribbon menu. Click on the 0.25 dimension so that it
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Figure 3.32 — Using the Properties window to remove a dimension extension line

To remove the dimension extension line that is covering the object line, select the Lines and
Arrows category and double click over the “On” text to the right of either the Ext Line 1 or Ext
Line 2 label to turn the extension line off. You may have to try both to see which extension line
is in fact the one overlapping the object line.
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Figure 3.33 — Turning off Ext Figure 3.34 — The extension line removed
lines

Next, to turn off the center marks on the radius and diameter dimensions, zoom out to view the
entire Rectangular Problem and select the R0.50, R0.40, @ 0.50 and @ 2.00 leaders so that each
leader is added to the selection set.
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Figure 3.35 — Turning off the center mark on five dimensions
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Under the Lines and Arrows field on the
Properties window, change the Center Mark
value from “Mark” to “None”. You can exit Color B Byloyer

Layer Dimension

the Properties window by clicking the X in =
Linetype scale |1.0000
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Figure 3.36 — Turn off the Center marks

Using the Edit Text Tool

To add text to the @ 0.50 dimension stating that this description applies to “4 holes”, you will
need to use the Edit Text tool. However, you can activate the Text Editor tab just by double-
clicking on the @ 0.50 dimension. Automatically, the Text Editor tab will appear, enabling you
to edit the dimension label. Move the cursor to the far right side of the 0.50 label and hit
ENTER to begin a new line. Type “4 holes” and click anywhere outside the text box to place the
new text. Close the Text Editor by selecting the X at the right end of the ribbon.
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Figure 3.37 — Adding text to a dimension
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Figure 3.38 — Finished dimensioning of the rectangular problem

Now that the Rectangular Problem has the “4 holes” added to the @ 0.50 dimension, this
problem is close to being finished. The last set of procedures will be to add text to the drawing,
which will be explained in the next chapter.

* World Class CAD Challenge 02-08 * - Close this drawing file. Create a New file and
draw the entire rectangular problem on proper layers, using proper dimensions on the
drawing. Continue this drill four times, each time completing the drawing under 10
minutes to maintain your World Class ranking. If you are under 10 minutes, you may
proceed to the next chapter, the Circular Problem.
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